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1	 Introduction

What is OpenType?

Developed jointly by Adobe and Microsoft, OpenType is a highly versatile modern font 
file format that represents a significant advance in type functionality on Apple Mac and 
Windows based computers.

Advantages

The three major groundbreaking characteristics of OpenType fonts are their multi-platform 
support, expanded character set, and glyph substitution. Multi-platform support means 
that an OpenType font will run on both the Mac and Windows platforms. 

This is a real convenience when your office uses both platforms or you use a PC at work 
and a Mac at home (or vice versa).

Expanded character set refers to the fact that OpenType fonts have the capacity to contain 
thousands of characters, as opposed to the 256-character capacity of the earlier Type 1 
and TrueType fonts.

Glyph substitution refers to the built-in intelligence some OpenType fonts have that 
enables them to ‘know’ when to insert situational glyphs including certain ligatures, 
swashes, or other special characters. For instance, some swash characters are intended 
to be used only at the beginning or end of a word. An OpenType font with this information 
programmed into it will only insert them in these instances when using a supporting 
application such as Adobe InDesign, Illustrator and Photoshop.

File Type

OpenType “.otf” fonts are compact single-file cross-platform fonts, which can have 
extended language support based on Unicode, and enhanced typographic layout 
features.

	 www.adobe.com/type/opentype
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OpenType Features

Apple II Pro and Apple II Alt Pro take full advantage of OpenType default features plus 
many additional custom stylistic sets.

Default Features

All OpenType features deal with the replacement of characters. It always comes down 
to the same thing: substitute a single character or a sequence of characters by another 
character. The difference can be as subtle as a slightly longer or shorter descender, or as 
distinctive as a decorative swash or something totally different like MouseText.

These alternates can fall under the OpenType Default Category of swash characters, 
contextual, stylistic or titling alternates, or discretionary ligatures, and can offer options 
to vary the overall look, personality, and sometimes legibility of a typeface. In addition, 
they can be combined and randomly substituted for the default character to create a more 
natural, less repetitive flow, which can be desirable in handwriting, calligraphic, and script 
fonts.

Custom Stylistic Sets

Stylistic sets are custom OpenType features that can vary from font to font, each makes 
it easier to use a font’s alternate characters. Instead of leaving it to the user to manually 
replace every incidence of a character with a desired alternate. A stylistic set allows users 
to select an entire range of text, and apply this one kind of substitution. Stylistic sets are 
available in most modern design software.

Different fonts may contain different stylistic sets anywhere from one to 20 sets of 
alternates. Both Apple II Pro and Apple II Alt Pro contain several stylistic sets.

	 www.opentypecookbook.com

Symbols for Legacy Computing

Version 13.0 of the Unicode Standard, released March 2020, includes many (but not all) of 
the MouseText characters in the Symbols for Legacy Computing block. Those that are, can 
be found in Apple II Pro and Apple II Alt Pro corresponding to the correct Unicode.

	 www.unicode.org
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Enable OpenType Features

Apple Applications

All native Apple applications including Pages, Keynote, Numbers and TextEdit support 
OpenType features. First you need to show the Fonts window which can be found via the 
Format menu or by using the keyboard shortcut CMD+T. Then click the little gear icon 
button and choose Typography, a list of available features will be shown.

Adobe Photoshop

In Photoshop, the OpenType features can be found in the Character panel which is 
accessed via the Window menu. There are some handy shortcuts in the main panel or you 
can access a list via the top right menu icon.

Adobe Illustrator

Illustrator is a little different to Photoshop, the OpenType features are not in the Character 
panel instead they have their own OpenType panel which can be accessed via the 
Window > Type menu. 

Adobe InDesign

OpenType features are enabled via the Character window using InDesign. Unlike 
Photoshop there are not currently any shortcuts in the main panel so you will need to click 
the menu button in the top right corner of the window and go to OpenType.

Microsoft Word

To access OpenType features in MS Word, go to Modify Style, click Format then select 
Font, once the dialog box appears select the Advanced tab and OpenType Features will 
appear for selection and modification.

LibreOffice

An Open Source and Free Office Suite with a full range of OpenType features.

	 www.libreoffice.org
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2	 Apple II Pro

Apple II Pro is a vastly expanded version of the original Apple IIc and Apple IIe internal 
character sets all combined into one font which is also WGL4 compliant.

	🗊 WGL4 fonts is a glyph list published by Microsoft Corporation.

Character Coverage

Code Pages:

	✓ 1252 Latin 1 	✓ 1254 Turkish

	✓ 1250 Latin 2: Eastern Europe 	✓ 1257 Windows Baltic

	✓ 1251 Cyrillic 	✓ Macintosh Character Set (Roman)

	✓ 1253 Greek 	✓ OEM Character Set

Unicode Ranges:

	✓ Basic Latin 	✓ Control Pictures

	✓ Latin-1 Supplement 	✓ Box Drawing

	✓ Latin Extended-A 	✓ Block Elements

	✓ Spacing Modifier Letters 	✓ Geometric Shapes

	✓ Spacing Modifier Letters 	✓ Misc. Mathematical Symbols-A

	✓ Greek and Coptic 	✓ Supplemental Arrows-A

	✓ Cyrillic 	✓ Misc. Mathematical Symbols-B

	✓ Cyrillic Supplement 	✓ Supplemental Mathematical Operators

	✓ General Punctuation 	✓ Misc. Symbols and Arrows

	✓ Superscripts and Subscripts 	✓ Cyrillic Extended-A

	✓ Currency Symbols 	✓ Supplemental Punctuation

	✓ Letter like Symbols 	✓ Cyrillic Extended-B

	✓ Number Forms 	✓ Modifier Tone Letters

	✓ Arrows 	✓ Private Use Area (plane 0)

	✓ Mathematical Operators 	✓ Alphabetic Presentation Forms

	✓ Miscellaneous Technical
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Main Character Sets

Basic Latin

1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ 

abcdefghijklmnopqrstuvwxyz~@#$%^&*()_+`-= 

[]{};’\:”“|,./<>?\ 

Accented Characters

áâäàåãăāąǽçćčĉċďđĕěėēęéêèŋ 

ğĝģġħĥĭíîïìīįĩĵñŉóôöòõőŏōǿøķłĺľļŀ 

ńňņŕřŗśşŝšșŧťţúûüùŭűūųůũ 

ẃŵẅẁýÿŷỳźžż`´ˆ˘˚˝˛ 

 

ĂĀÁÂÄÀÅÃĄǼĆČĈĊĎĐĔĚĖĒŊĘĘĞĜĢĠĤĬĲĪĮĨĴĶĹĽĻĿŁ 

ŃŇŅŎŐŌǾŔŘŖŚŞŜȘŦŤŢŬŰŪŲŮŨẂŴẄ 

ẀŶỲŹŻİÇÉÊËÈÍÎÏÌÑÓÔÖÒÕØŠÚÛÜÙÝŽ

Cyrillic

А Б В Г Ґ Д Е Ж З И Й К Л М Н О П Р С Т У 

Ф Х Ц Ч Ш Щ Ъ Ы Ь Э Ю Я Ё Ђ Ѓ Є Ѕ І Ї Ј Љ 

Њ Ћ Ќ Ў Џ Ѣ 

 

а б в г ґ д е ж з и й к л м н о п р с т у 

ф х ц ч ш щ ъ ы ь э ю я ё ђ ѓ є ѕ і ї ј љ 

њ ћ ќ ў џ ѣ
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Greek

Α Β Γ Δ Ε Ζ Η Θ Ι Κ Λ Μ Ν Ξ Ο Π Ρ Τ Υ Φ Χ 

Ψ Ω Ά Έ Ή Ί Ϊ Ό Ύ Ϋ Ώ Σ 

 

α β γ δ ε ζ η θ ι κ λ μ ν ξ ο π ρ τ υ φ χ 

ψ ω ά έ ή ί ϊ ό ύ ϋ ώ σ

OpenType Standard Features

	✓ Standard Ligatures 	✓ Titling Alternatives

	 Contextual Alternatives 	✓ Ordinals

	✓ Discretionary Ligatures 	✓ Fractions

	✓ Swash 	✓ Stylistic Sets

	✓ Stylistic Alternatives

Standard Ligatures

ff fi fl ⌠t ffi ffl

ff fi fl st ffi ffl

Discretionary Ligatures

Th ct fb fh fj fk ft st ffb

Th ct fb fh fj fk ft st ffb
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Swash (Script Characters)

a b c d e f g h i j k l m n

a b c d e f g h i j k l m n

o p q r s t u v w x y z @ &

o p q r s t u v w x y z @ &

Stylistic Alternatives - Inverse (Negative)

The Negative or (Inverse) character set contains the most popular used characters 
covering the Code Page 1251 Latin 1. For a complete Inverse Character Set, Apple II NEG 
Pro is available for use.

Titling Alternatives - Italic Characters

A B C D E F G H I J K L

M N O P Q R S T U V W X

Y Z a b c d e f g h i j

k l m n o p q r s t u v

w x y z 0 1 2 3 4 5 6 7

8 9 ! @ # $ % ^ & * ( )

+ = [ ] : ; { | } ? / \
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Ordinals

0 1 2 3 4 5 6 7 8 9

0 1 2 3 4 5 6 7 8 9

+ - = ( ) n No.

+ − = ( ) n No.

Fractions

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8
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Stylistic Sets

Apple II Pro contains the following stylistic sets:

1.	 MouseText 
		  Pseduo GUI - 32 Characters.

2.	Small Fractions 
		  Three characters become one character.

3.	Segmented Digital 
		  Digital Clock Numbers.

4.	Script Lowercase 
		  Small case letters hand written in appearance.

5.	Small Caps Alphanumeric 
		  Capital letters which are the height of small case letters.

6.	Inverse 
		  Negative Character Set

7.	 Italic 
		  Slanted characters.

8.	Bold 
		  Heavier set characters.

	✏ Some applications such as MS Word 2016 will show only the stylistic number not the actual name.

Apple MouseText Characters

MouseText is a set of 32 graphical characters first implemented in the Apple //c to create a 
pseudo graphical interface. They were then retrofitted to the Apple IIe forming part of the 
Enhanced IIe upgrade. 

Apple II Pro uses the same corresponding ASCII characters as per the Apple Reference 
Manual which can be accessed by choosing Stylistic Set 1.

	✏ Some Stylistic Sets are duplicates of OpenType Defaults; for applications such as Microsoft Office 2016 	
	 which doesn’t support all OpenType Defaults.
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Stylistic Set 01 – MouseText

@ A B C D E F G H I J K L M N O

@ A B C D E F G H I J K L M N O

P Q R S T U V W X Y Z [ \ ] ^ _

P Q R S T U V W X Y Z [ \ ] ^ _

Stylistic Set 02 – Small Fractions

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

Stylistic Set 03 – Segmented Digital

0 1 2 3 4 5 6 7 8 9

Stylistic Set 04 – Script Lowercase

a b c d e f g h i j k l m n

a b c d e f g h i j k l m n

o p q r s t u v w x y z @ &

o p q r s t u v w x y z @ &
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Stylistic Set 05 – Small Caps

0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J

K L M N O P Q R S T

U V W X Y z

	✏ Apple II Pro contains actual small cap characters. Some applications such as Word 2016 use computer 		
	 generated ones that are just reduced capitals. Such characters are considered to be typographically 		
	 undesirable by professionals.

Stylistic Set 06 – Inverse (Negative)

Negative or (Inverse) contains the most popular used characters, Code Page 1251 Latin 1. 
For a complete Inverse Character Set, Apple II NEG Pro can be used.

Stylistic Set 07 – Italic

A B C D E F G H I J K L

M N O P Q R S T U V W X

Y Z a b c d e f g h i j

k l m n o p q r s t u v

w x y z 0 1 2 3 4 5 6 7

8 9 ! @ # $ % ^ & * ( )

+ = [ ] : ; { | } ? / \
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Stylistic Set 08 – Bold

A B C D E F G H I J

K L M N O P Q R S T

U V W X Y Z

a b c d e f g h i j

k l m n o p q r s t

u v w x y z

0 1 2 3 4 5 6 7 8 9

< > { | } [ ] ( ) ?

~ @ # $ % & _ ` - =

. , + * ^ / \ : ;

	 Adobe InDesign Custom Glyph Sets

You can create your own library of often-used symbols or special characters—for instance, 
a collection of currency symbols—by creating a custom glyph set.

Open the Glyphs panel from the Type menu or the Window > Type and Tables sub menu. 
Choose New Glyph Set from the panel menu, and name it.

Then select a glyph in the panel, and choose Add to Glyph Set from the panel menu or 
from the contextual menu (right-click on the glyph). You can include glyphs from different 
typefaces in the same glyph set.

Being able to load your custom-made sets (choose it from the top of the Show pop-up 
menu, or choose View Glyph Set from the panel menu) in the Glyphs panel saves you 
from having to scroll through the entire font’s worth of glyphs just to find that one you 
need.
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3	 Apple II Alt Pro

Apple II Alt Pro is an alternate version of Apple II Pro with a reduced character set 
featuring the upper and lowercase alphabet having a more serif look, plus a different 
numeric set.

Character Coverage

Code Pages:

	 1252 Latin 1 	 1254 Turkish

	 1250 Latin 2: Eastern Europe 	 1257 Windows Baltic

	 1251 Cyrillic 	 Macintosh Character Set (Roman)

	 1253 Greek 	✓ OEM Character Set

Unicode Ranges:

	✓ Basic Latin 	✓ Control Pictures

	✓ Latin-1 Supplement 	✓ Box Drawing

	 Latin Extended-A 	✓ Block Elements

	 Spacing Modifier Letters 	 Geometric Shapes

	 Spacing Modifier Letters 	 Misc. Mathematical Symbols-A

	 Greek and Coptic 	✓ Supplemental Arrows-A

	 Cyrillic 	✓ Misc. Mathematical Symbols-B

	 Cyrillic Supplement 	 Supplemental Mathematical Operators

	✓ General Punctuation 	✓ Misc. Symbols and Arrows

	✓ Superscripts and Subscripts 	 Cyrillic Extended-A

	✓ Currency Symbols 	✓ Supplemental Punctuation

	 Letter like Symbols 	 Cyrillic Extended-B

	✓ Number Forms 	 Modifier Tone Letters

	✓ Arrows 	✓ Private Use Area (plane 0)

	 Mathematical Operators 	✓ Alphabetic Presentation Forms

	 Miscellaneous Technical
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Main Character Set

Basic Latin

1234567890ABCDEFGHIJKLMNOPQRSTUVWXYZ 

abcdefghijklmnopqrstuvwxyz~@#$%^&*()_+`-= 

[]{};’\:”“|,./<>?\øØ 

OpenType Standard Features

	✓ Standard Ligatures 	 Titling Alternatives

	 Contextual Alternatives 	✓ Ordinals

	✓ Discretionary Ligatures 	✓ Fractions

	✓ Swash 	✓ Stylistic Sets

	✓ Stylistic Alternatives

Standard Ligatures

ff fi fl ſt ffi ffl

ff fi fl st ffi ffl

Discretionary Ligatures

Th ct fb fh fj fk ft st ffb

Th ct fb fh fj fk ft st ffb
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Swash (Script Characters)

a b c d e f g h i j k l m n

a b c d e f g h i j k l m n

o p q r s t u v w x y z @ &

o p q r s t u v w x y z @ &

Stylistic Alternatives - Inverse (Negative)

The Negative or (Inverse) character set contains the most popular used characters. For a 
complete Inverse Character Set, Apple II Alt NEG Pro is available for use.

Ordinals

0 1 2 3 4 5 6 7 8 9

0 1 2 3 4 5 6 7 8 9

+ - = ( ) n

+ − = ( ) n

Fractions

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8
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Stylistic Sets

Apple II Alt Pro contains the following stylistic sets:

1.	 MouseText Running Man 
		  Pseudo GUI - 32 Characters.

2.	Small Fractions 
		  Three characters become one character.

3.	Segmented Digital 
		  Numbers similar to a digital clock.

4.	Script Lowercase 
		  Small case letters hand written in appearance.

5.	Small Caps Alphanumeric 
		  Capital letters which are the height of small case letters.

6.	Inverse 
		  Negative character set.

	✏ Some applications such as MS Word 2016 will show only the stylistic number not the actual name.

Apple MouseText Characters

MouseText is a set of 32 graphical characters first implemented in the Apple //c to create a 
pseudo graphical interface. They were then retrofitted to the Apple IIe forming part of the 
Enhanced IIe upgrade. 

Apple II Alt Pro uses the same corresponding ASCII characters as per the Apple Reference 
Manual which can be accessed by choosing Stylistic Set 1.

	✏ Some Stylistic Sets are duplicates of OpenType Defaults; for applications such as Microsoft Office 2016 	
	 which doesn’t support all OpenType Defaults.



19]Apple II Pro�

Stylistic Set 01 – MouseText

@ A B C D E F G H I J K L M N O

@ A B C D E F G H I J K L M N O

P Q R S T U V W X Y Z [ \ ] ^ _

P Q R S T U V W X Y Z [ \ ] ^ _

Stylistic Set 02 – Small Fractions

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

1/2 1/3 1/4 1/5 1/6 1/7 1/8 1/9 1/10

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

2/3 2/5 3/4 3/5 3/8 4/5 5/6 5/8 7/8

Stylistic Set 03 – Segmented Digital

0 1 2 3 4 5 6 7 8 9

Stylistic Set 04 – Script Lowercase

a b c d e f g h i j k l m n

a b c d e f g h i j k l m n

o p q r s t u v w x y z @ &

o p q r s t u v w x y z @ &
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Stylistic Set 05 – Small Caps

0 1 2 3 4 5 6 7 8 9

A B C D E F G H I J

K L M N O P Q R S T

U V W X Y Z

	✏ Apple II Alt Pro contains actual small cap characters. Some applications such as Word 2016 use 		
	 computer generated ones that are just reduced capitals. Such characters are considered to be 			
	 typographically undesirable by professionals.

Stylistic Set 06 – Negative (Inverse)

The Negative or (Inverse) stylistic set contains the most popular used characters. For a 
complete Inverse Character Set, Apple II Alt NEG Pro can be used.  

	 Adobe InDesign Custom Glyph Sets

You can create your own library of often-used symbols or special characters—for instance, 
a collection of currency symbols—by creating a custom glyph set.

Open the Glyphs panel from the Type menu or the Window > Type and Tables submenu. 
Choose New Glyph Set from the panel menu, and name it.

Then select a glyph in the panel, and choose Add to Glyph Set from the panel menu or 
from the contextual menu (right-click on the glyph). You can include glyphs from different 
typefaces in the same glyph set.

Being able to load your custom-made sets (choose it from the top of the Show pop-up 
menu, or choose View Glyph Set from the panel menu) in the Glyphs panel saves you 
from having to scroll through the entire font’s worth of glyphs just to find that one you 
need.
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4	 Alternate Character Shortcuts

	ě Macintosh

Font Book

Font Book lets you easily install and preview fonts; search through them for almost any 
glyph or character effortlessly.

	 https://support.apple.com/en-ca/guide/font-book/toc

	ę Microsoft Windows

Alt key

In Microsoft Windows, holding down the Alt key while typing in numbers (often referred 
to as Alt codes) on the numeric keypad allows the user to type special characters not 
normally available on the keyboard such as foreign languages, symbols and more. 

The following tables features keyboard shortcuts to access the most commonly used 
alternate characters for Microsoft Windows.

With Numeric Keypad

a.	Make sure your keyboard has a numeric keypad.

b.	Make sure the numeric keypad is enabled by pressing the  key. The Num Lock’s led 	
	 light will turn on indicating that the numeric keypad is enabled.

c.	 Place your screen cursor on the location where you want to insert the special 			 
	 character.

d.	Press and hold down the  key on the left side of the keyboard.

e.	On the numeric keypad, type the sequence of numbers (table shown below) that 		
	 corresponds to the character you want to insert.

f.	 Release the  key and the special character will appear at your cursor’s location.
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The ALT code for the Greek capital letter omega Ω is 234 on the Windows ALT Code 
Symbols page. Press and hold the  key, type    on the numeric keypad, then 
release the  key.

The ALT code for the Latin small letter e with circumflex ê is 0234 on the Windows 
ALT Code Symbols page. Press and hold the  key, type     on the numeric 
keypad, then release the  key.

	✏ The leading zero makes all the difference!

 + <###>, where ### is the decimal code point value of a character, generates an 
OEM-encoded character {IBM Code Page 437 / MS-DOS}.

 + <0###>, where ### is the decimal code point value of a character, generates a 		
Windows-encoded character {Code Page 1252 Windows Latin 1 ANSI}.

Without Numeric Keypad

a.	On a laptop keyboard, a set of keys have a secondary function, that when enabled, 		
	 makes them act as a numeric keypad.

b.	Locate the Function or  key on the bottom left of the keyboard.

c.	 Locate the Num Lock or Num Lk key on the top right of the keyboard.

d.	Press and hold the  key, press and release the  key, release the  key. 			 
	 The laptop’s numeric keypad is now enabled.

e.	Place your screen cursor on the location where you want to insert the special 			 
	 character.

f.	 Press and hold down the  key on the left side of the keyboard.

g.	On the numeric keypad, type the sequence of numbers (decimal code point value) that 	
	 corresponds to the character you want to insert.

h.	Release the  key.

i.	 The special character will appear at your cursor’s location.

j.	 Repeat step 3 to disable the numeric keypad.

	✏ On some laptops, simply pressing Fn and ALT at the same time, then typing the sequence of numbers 		
	 (decimal code point value) on the numeric keypad will work.
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Alt Code Tables

Punctuation Signs

Char Sequence Description Char Sequence Description

¡ 173 Inverted exclamation mark ‚ 0130 Single low-9 quotation mark

¦ 0166 Broken bar, parted rule “ 0147 Left double quotation mark

§ 21 Section sign ” 0148 Right double quotation mark

« 174 Left-pointing double angle quotation mark „ 0132 Double low-9 quotation mark

» 175 Right-pointing double angle quotation mark † 0134 Dagger, obelisk, cross

° 248 Degree sign ‡ 0135 Double dagger, double obelisk, diesis

¶ 20 Pilcrow sign, paragraph sign • 7 Bullet

· 250 Middle dot, midpoint … 0133 Horizontal ellipsis, three dot leader

¿ 168 Inverted question mark ‰ 0137 Per mille sign, per thousand

– 0150 En dash ‹ 0139 Single left-pointing angle quotation mark

— 0151 Em dash › 0155 Single right-pointing angle quotation mark

‘ 0145 Left single quotation mark ‼ 19 Double exclamation mark

’ 0146 Right single quotation mark á 160 Latin small letter a with acute

Latin Letters with Diacritical Marks (Accents)

Char Sequence Description Char Sequence Description

Á 0193 Latin capital letter A with acute Ñ 165 Latin capital letter N with tilde

à 133 Latin small letter a with grave ó 162 Latin small letter o with acute

À 0192 Latin capital letter A with grave Ó 0211 Latin capital letter O with acute

â 131 Latin small letter a with circumflex ò 149 Latin small letter o with grave

Â 0194 Latin capital letter A with circumflex Ò 0210 Latin capital letter O with grave

ä 132 Latin small letter a with diaeresis ô 147 Latin small letter o with circumflex

Ä 142 Latin capital letter A with diaeresis Ô 0212 Latin capital letter O with circumflex

ã 0227 Latin small letter a with tilde ö 148 Latin small letter o with diaeresis

Ã 0195 Latin capital letter A with tilde Ö 153 Latin capital letter O with diaeresis

å 134 Latin small letter a with ring above õ 0245 Latin small letter o with tilde

Å 143 Latin capital letter A with ring above Õ 0213 Latin capital letter O with tilde

æ 145 Latin small letter ae ø 248 Latin small letter o with stroke

Æ 146 Latin capital letter AE Ø 0216 Latin capital letter O with stroke

ç 135 Latin small letter c with cedilla œ 0156 Latin small ligature oe

Ç 128 Latin capital letter C with cedilla Œ 0140 Latin capital ligature OE
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ð 0240 Latin small letter eth š 0154 Latin small letter s with caron

Ð 0208 Latin capital letter ETH Š 0138 Latin capital letter S with caron

é 130 Latin small letter e with acute ß 225 Latin small letter sharp s

É 144 Latin capital letter E with acute þ 0254 Latin small letter thorn

è 138 Latin small letter e with grave Þ 0222 Latin capital letter THORN

È 0200 Latin capital letter E with grave ú 163 Latin small letter u with acute

ê 136 Latin small letter e with circumflex Ú 0218 Latin capital letter U with acute

Ê 0202 Latin capital letter E with circumflex ù 151 Latin small letter u with grave

ë 137 Latin small letter e with diaeresis Ù 0217 Latin capital letter U with grave

Ë 0203 Latin capital letter E with diaeresis Û 150 Latin small letter u with circumflex

ƒ 159 Florin sign, function sign Û 0219 Latin capital letter U with circumflex

í 161 Latin small letter i with acute ü 129 Latin small letter u with diaeresis

Í 0205 Latin capital letter I with acute Ü 154 Latin capital letter U with diaeresis

ì 141 Latin small letter i with grave ý 0253 Latin small letter y with acute

Ì 0204 Latin capital letter I with grave Ý 0221 Latin capital letter Y with acute

î 140 Latin small letter i with circumflex ÿ 152 Latin small letter y with diaeresis

Î 0206 Latin capital letter I with circumflex Ÿ 0159 Latin capital letter Y with diaeresis

ï 139 Latin small letter i with diaeresis Ž 0158 Latin small letter z with caron

Ï 0207 Latin capital letter I with diaeresis Ž 0142 Latin capital letter Z with caron

ñ 164 Latin small letter n with tilde

Diacritical / Accent Marks

Char Sequence Description Char Sequence Description

^ 94 Circumflex accent ´ 0180 Acute accent

` 96 Grave accent ¸ 0184 Cedilla

¨ 0168 Diaeresis ˆ 0136 Modifier Letter Circumflex Accent

¯ 0175 Macron, overline, overbar ˜ 0152 Small tilde

Greek Letters

Char Sequence Description Char Sequence Description

µ 230 Micro sign, mu α 224 Greek small letter alpha

Γ 226 Greek capital letter gamma δ 235 Greek small letter delta

Θ 233 Greek capital letter theta ε 238 Greek small letter epsilon

Σ 228 Greek capital letter sigma π 227 Greek small letter pi

τ 231 Greek capital letter tau σ 229 Greek small letter sigma

Φ 232 Greek capital letter phi φ 237 Greek small letter phi
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Ω 234 Greek capital letter omega

Intellectual Property

Char Sequence Description Char Sequence Description

™ 0153 Trade mark sign ® 0174 Registered sign

© 0169 Copyright sign

Currency Symbols

Char Sequence Description Char Sequence Description

$ 36 Dollar sign ¥ 157 Yen sign, yuan sign

€ 0128 Euro sign ₧ 158 Peseta sign

¢ 155 Cent sign ¤ 0164 Currency sign

£ 156 Pound sign, pound sterling, Irish punt

Superscripts

Char Sequence Description Char Sequence Description

ª 166 Feminine ordinal indicator ² 253 Superscript two, squared

º 167 Masculine ordinal indicator ³ 0179 Superscript three, cubed

¹ 0185 Superscript one ⁿ 252 Superscript Latin small letter n

Fractions

Char Sequence Description Char Sequence Description

¼ 172 Vulgar fraction one quarter ¾ 0190 Vulgar fraction three quarters

½ 171 Vulgar fraction one half

Gender & Astrological Symbols

Char Sequence Description Char Sequence Description

♀ 12 Female sign, alchemical symbol for copper ♂ 11 Male sign, alchemical symbol for iron

Emoticon / Emoji Symbols

Char Sequence Description Char Sequence Description

☺ 1 White smiling face, smiley face ☻ 2 Black smiling face

Musical Symbols

Char Sequence Description Char Sequence Description

♪ 13 Eighth note, quaver ♫ 14 Beamed eighth notes/quavers

Math Symbols

Char Sequence Description Char Sequence Description

∟ 28 Right angle ∩ 239 Intersection

+ 43 Plus sign ≡ 240 Identical to

< 60 Less-than sign ± 241 Plus-minus sign
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= 61 Equals sign ≥ 242 Greater-than or equal to

> 62 Greater-than sign ≤ 243 Less-than or equal to

| 124 Vertical line, vertical bar ⌠ 244 Top half integral

~ 126 Tilde ⌡ 245 Bottom half integral

⌐ 169 Reversed not sign, beginning of line ÷ 246 Division sign, obelus

¬ 170 Not sign, angled dash ≈ 247 Almost equal to, asymptotic to

× 0215 Multiplication sign ∙ 249 Bullet operator

∞ 236 Infinity √ 251 Square root, radical sign

Box Drawings

Char Sequence Description Char Sequence Description

─ 196 Box drawings light horizontal ═ 205 Box drawings double horizontal

│ 179 Box drawings light vertical ║ 186 Box drawings double vertical

┌ 218 Box drawings light down and right ╒ 213 Box drawings down single and right double

┐ 191 Box drawings light down and left ╓ 214 Box drawings down double and right single

└ 192 Box drawings light up and right ╔ 201 Box drawings double down and right

┘ 217 Box drawings light up and left ╕ 184 Box drawings down single and left double

├ 195 Box drawings light vertical and right ╖ 183 Box drawings down double and left single

┤ 180 Box drawings light vertical and left ╗ 187 Box drawings double down and left

┬ 194 Box drawings light down and horizontal ╘ 212 Box drawings up single and right double

┴ 193 Box drawings light up and horizontal ╙ 211 Box drawings up double and right single

┼ 197 Box drawings light vertical and horizontal ╚ 200 Box drawings double up and right

╛ 190 Box drawings up single and left double ╤ 209 Down single and horizontal double

╜ 189 Box drawings up double and left single ╥ 210 Down double and horizontal single

╝ 188 Box drawings double up and left ╦ 203 Box drawings double down and horizontal

╞ 198 Box drawings vertical single and right double ╧ 207 Up single and horizontal double

╟ 199 Box drawings vertical double and right single ╨ 208 Up double and horizontal single

╠ 204 Box drawings double vertical and right ╩ 202 Double up and horizontal

╡ 181 Box drawings vertical single and left double ╪ 216 Vertical single and horizontal double

╢ 182 Box drawings vertical double and left single ╫ 215 Vertical double and horizontal single

╣ 185 Box drawings double vertical and left ╬ 206 Double vertical and horizontal

Block Elements

Char Sequence Description Char Sequence Description

░ 176 Light shade ▄ 220 Lower half block

▒ 177 Medium shade, speckles fill, dotted fill ▌ 221 Left half block
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▓ 178 Dark shade ▐ 222 Right half block

█ 219 Full block, solid block ▀ 223 Upper half block

Geometric Shapes

Char Sequence Description Char Sequence Description

◘ 8 Inverse bullet ▬ 22 Black rectangle

○ 9 White circle ▲ 30 Black up-pointing triangle

◙ 10 Inverse white circle ▼ 31 Black down-pointing triangle

► 16 Black right-pointing pointer ■ 254 Black square

◄ 17 Black left-pointing pointer

Arrows

Char Sequence Description Char Sequence Description

↕ 18 Up down arrow → 26 Rightwards arrow, Z notation total function

↨ 23 Up down arrow with base ← 27 Leftwards arrow

↑ 24 Upwards arrow ↔ 29 Left right arrow, Z notation relation

↓ 25 Downwards arrow

Playing Cards

Char Sequence Description Char Sequence Description

♥ 3 Black heart suit ♣ 5 Black club suit

♦ 4 Black diamond suit ♠ 6 Black spade suit

Miscellaneous

Char Sequence Description Char Sequence Description

☼ 15 White sun with rays ⌂ 127 House
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ASCII Char. Full description ASCII Char. Full description

032 Empty Space 057 9 Number nine

033 ! Exclamation mark 058 : Colon

034 " Quotation mark; quotes 059 ; Semicolon

035 # Number sign 060 < Less-than sign

036 $ Dollar sign 061 = Equals sign

037 % Percent sign 062 > Greater-than sign

038 & Ampersand 063 ? Question mark

039 ' Apostrophe 064 @ AT sign

040 ( Round brackets or parentheses 065 A Capital A

041 ) Round brackets or parentheses 066 B Capital B

042 * Asterisk 067 C Capital C

043 + Plus sign 068 D Capital D

044 , Comma 069 E Capital E

045 - Hyphen 070 F Capital F

046 . Dot, full stop 071 G Capital G

047 / Slash 072 H Capital H

048 0 Number zero 073 I Capital I

049 1 Number one 074 J Capital J

050 2 Number two 075 K Capital K

051 3 Number three 076 L Capital L

052 4 Number four 077 M Capital M

053 5 Number five 078 N Capital N

054 6 Number six 079 O Capital O

055 7 Number seven 080 P Capital P

056 8 Number eight 081 Q Capital Q

5	 ASCII Character Set

American Standard Code Characters

The following tables represent only characters 32-127 which are the standard, 
implementation-independent alphanumeric characters that are most commonly used.
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082 R Capital R 116 t Lowercase t

083 S Capital S 117 u Lowercase u

084 T Capital T 118 v Lowercase v

085 U Capital U 119 w Lowercase w

086 V Capital V 120 x Lowercase

087 W Capital W 121 y Lowercase y

088 X Capital X 122 z Lowercase z

089 Y Capital Y 123 { Curly brackets or braces

090 Z Capital Z 124 | Vertical-bar, VBAR, vertical line

091 [ Square brackets 125 } Curly brackets or braces

092 \ Backslash 126 ~ Tilde; swung dash

093 ] Square brackets 127 Delete

094 ^ Caret or circumflex accent 128 Ç Majuscule C-cedilla

095 _ Underscore 129 ü Letter "u" with umlaut or diareses

096 ` Grave accent 130 é Letter "e" with acute or "e-acute"

097 a Lowercase a 131 â a-circumflex

098 b Lowercase b 132 ä Letter "a" with umlaut or diareses

099 c Lowercase c 133 à Letter "a" with grave accent

100 d Lowercase d 134 å Letter "a" with a ring

101 e Lowercase e 135 ç Minuscule c-cedilla

102 f Lowercase f 136 ê e-circumflex

103 g Lowercase g 137 ë Letter "e" with umlaut or diareses

104 h Lowercase h 138 è Letter "e" with grave accent

105 i Lowercase i 139 ï Letter "i" with umlaut or diareses

106 j Lowercase j 140 î i-circumflex

107 k Lowercase k 141 ì Letter "i" with grave accent

108 l Lowercase l 142 Ä Letter "A" with umlaut or diareses

109 m Lowercase m 143 Å Capital letter "A" with a ring

110 n Lowercase n 144 É Capital letter "E" with acute accent

111 o Lowercase o 145 æ Latin diphthong "ae" in lowercase

112 p Lowercase p 146 Æ Latin diphthong "AE" in uppercase

113 q Lowercase q 147 ô o-circumflex

114 r Lowercase r 148 ö Letter "o" with umlaut or diareses

115 s Lowercase s 149 ò Letter "o" with grave accent
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150 û u-circumflex 184 © Copyright symbol

151 ù Letter "u" with grave accent 185 ╣ Box drawing character

152 ÿ Lowercase letter "y" with diareses 186 ║ Box drawing character

153 Ö Letter "O" with umlaut or diareses 187 ╗ Box drawing character

154 Ü Letter "U" with umlaut or diareses 188 ╝ Box drawing character

155 ø Slashed zero or empty set 189 ¢ Cent symbol

156 £ Symbol for the pound sterling 190 ¥ YEN and YUAN sign

157 Ø Slashed zero or empty set 191 ┐ Box drawing character

158 × Multiplication sign 192 └ Box drawing character

159 ƒ Function sign; florin sign 193 ┴ Box drawing character

160 á Letter "a" with acute accent 194 ┬ Box drawing character

161 í Letter "i" with acute accent 195 ├ Box drawing character

162 ó Letter "o" with acute accent 196 ─ Box drawing character

163 ú Letter "u" with acute accent 197 ┼ Box drawing character

164 ñ Letter "n" with tilde; enye 198 ã Lowercase letter "a" with tilde

165 Ñ Letter "N" with tilde; enye 199 Ã Capital letter "A" with tilde

166 ª Feminine ordinal indicator 200 ╚ Box drawing character

167 º Masculine ordinal indicator 201 ╔ Box drawing character

168 ¿ Inverted question marks 202 ╩ Box drawing character

169 ® Registered trademark symbol 203 ╦ Box drawing character

170 ¬ Logical negation symbol 204 ╠ Box drawing character

171 ½ One half 205 ═ Box drawing character

172 ¼ Quarter or one fourth 206 ╬ Box drawing character

173 ¡ Inverted exclamation marks 207 ¤ Generic currency sign

174 « Angle quotes or guillemets 208 ð Lowercase letter "eth"

175 » Guillemets or angle quotes 209 Ð Capital letter "Eth"

176 ░ Light Shade 210 Ê E-circumflex

177 ▒ Medium Shade 211 Ë E-umlaut

178 ▓ Dark Shade 212 È Letter "E" with grave accent

179 │ Box drawing character 213 ı Lowercase dot less i

180 ┤ Box drawing character 214 Í Capital letter "I" with acute accent

181 Á Capital letter "A" with acute accent 215 Î Letter "I" with circumflex accent

182 Â A-circumflex 216 Ï Letter "I" with umlaut or dieresis

183 À Letter "A" with grave accent 217 ┘ Box drawing character
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218 ┌ Box drawing character 237 Ý Capital letter "Y" with acute accent

219 █ Block 238 ¯ Macron symbol

220 ▄ Lower Half Block 239 ´ Acute accent

221 ¦ Vertical broken bar 240 - Hyphen

222 Ì Letter "I" with grave accent 241 ± Plus-minus sign

223 ▀ Upper Half Block 242 _ Underline or underscore

224 Ó Capital letter "O" with acute accent 243 ¾ Three quarters

225 ß Letter "Eszett"; "scharfes S" or "sharp S" 244 ¶ Paragraph sign or pilcrow

226 Ô O-circumflex 245 § Section sign

227 Ò Letter "O" with grave accent 246 ÷ The division sign; Obelus

228 õ Letter "o" with tilde or "o-tilde" 247 ¸ Cedilla

229 Õ Letter "O" with tilde or "O-tilde" 248 ° Degree symbol

230 μ Lowercase letter "Mu"; micro sign 249 ¨ Diaresis

231 þ Lowercase letter "Thorn" 250 · Interpunct or space dot

232 Þ Capital letter "thorn" 251 ¹ Superscript one

233 Ú Capital letter "U" with acute accent 252 ³ Cube or superscript three

234 Û U-circumflex 253 ² Square or superscript two

235 Ù Letter "U" with grave accent 254 ■ Black square

236 Ý Lowercase letter "y" with acute accent 255 Space or no-break space
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6	 Apple II Personal Computer

	ě AppleSoft MouseText

The following Applesoft basic program requires an actual Apple //c, Apple IIe Enhanced or 
an Apple IIGS Personal Computer System, this program can also be tested on a software 
based emulator such as AppleWin - MS Windows or Virtual II - Apple MacIntosh. 

Basic Program

10 D$ = CHR$ (4): REM CONTROL-D 
20 PRINT: PRINT D$; "PR#3" : REM TURN ON 80-COLUMN CARD 
30 INVERSE 
40 PRINT CHR$ (27);"@ABCDEFGHIJKLMNOPQRSTUVWXYZ[\]^_";: 
   REM PRINT ALTERNATE CHARACTER SET 
50 PRINT CHR$ (24);: REM TURN OFF THE ALTERNATE CHARACTER SET 
60 NORMAL : REM TURN OFF INVERSE 

Download Apple II Emulator

 

AppleWin - Copy and Paste Procedure

1.	 Select and copy the basic program code shown above and switch to AppleWin,  
	 the program needs to be running in Apple //e Enhanced mode.

2.	Select AppleWin Configuration.

3.	Select Input following by selecting the Paste From Clipboard button.

4.	Select the OK button, the program code will fill the screen.

5.	At the command prompt ]� type RUN and press Enter, the display will change 
	 to 80 columns and display MouseText characters on screen. 

https://www.virtualii.com/
https://github.com/AppleWin/AppleWin
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	ě Apple II MouseText Simulated Screens

The following Apple II Screens were created with Adobe InDesign using the Apple II Pro 
OpenType font without the need of any graphic images. 

 
 
    A    File   Edit                      
  _____ZLLLLLLLL_ 
 Z     Z  Open  _ 
 Z     Z  New   _\\\\\\Letter1\\\\\\\\\\_ 
 Z     Z  Save  _                     ZR_ 
 Z     Z  Close _these fonts are more ZV_ 
 Z     Z  Quit  _amazing than the new ZV_ 
 Z      LLLLLLLL Apple M1 chip.       ZV_ 
 Z        _ Z                         ZV_ 
 Z        _ Z                         ZV_ 
 Z        _ Z  I left my heart in     ZV_ 
 Z        _ Z  San Francisco!         ZV_ 
 Z        _ Z  Totally Awesome....    ZV_ 
 Z        _ Z                         Z\_ 
  LLLLLLLL  Z           Thanks again, ZV_ 
  ________  Z                         ZV_ 
 Z        _ Z           Meister Cooke ZQ_ 
 Z        _ Z                         Z^_ 
 Z        _  LLLLLLLLLLLLLLLLLLLLLLLLLLL 
 Z        _  
 Z        _  
 Z        _  
  LLLLLLLL 
 
 

  
   
 DEMOPROGRAM                    v. 2.00 
----------------------------------------- 
 A ?  for Help 
 
 ↑  ↓  ←  →  to Select 
----------------------------------------- 
 
 
 
 
 
          XY  Editing Menu 
 
        √ XY  HOUSEKEEPING MENU 
 
          XY  Printing Menu 
 
 
 
 
 
 
 
√ indicates current selection 
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Adobe Illustrator, InDesign, Photoshop are either registered trademarks or trademarks of Adobe in the 
United States and/or other countries. 
 
OpenType and Windows are either registered trademarks or trademarks of Microsoft Corporation in the 
United States and/or other countries. 
 
AppleSoft Basic Program was extracted from the Apple IIe Enhanced User's Guide. 
Apple II, MacIntosh are trademarks of Apple Inc. registered in the United States and other countries.  
Copyright © Apple Inc. 
 
AppleWin 
Copyright © 1994-1996 Michael O'Brien 
Copyright © 2001 Oliver Schmidt 
Copyright © 2002-2005 Tom Charlesworth 
 
Copyright © 2006-2019 
Tom Charlesworth, Michael Pohoreski, Nick Westgate, Linards Ticmanis

Virtual II 
Copyright © Gerard Putter

All other trademarks are the property of their respective owners. 
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Vintage Apple II Advertisement

C

M

Y

CM

MY

CY

CMY

K

What The Font?

1

2

3

4

2

1. Goudy Heavyface Condensed Regular
2. Century Old Style Regular / Italic
3. Century Bold Condensed
4. Apple Motter Tektura

Pantone® and other Pantone trademarks are the property of Pantone LLC. 

PANTONE
368 C

PANTONE
123 C

PANTONE
165 C

PANTONE
186 C

PANTONE
253 C

PANTONE
299 C

Vintage Apple Computer Magazine Advertisement
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